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Chapter 1
Introduction

Thank you for choosing the Medtronic MiniMed Guardian Solutions software (MMT-7315). This
software allows you to retrieve the glucose data that is stored in the Guardian and view it on your
computer. The Com-Station is an accessory and is used as the communication device between the
computer and the Guardian,

For detailed information regarding the operation of the Guardian and Com-Station refer to the
User Guides for these devices.

)mmmmgsnm

Medtronic MiniMed provides a help line for assistance in troubleshooting software problems
Monday through Friday from 8:00am-5:00pm Pacific Time.

Department . Telephone Number
Product Help Line within the United States and Canada | 800-646-4633
800-Minimed
Product Help Line outside the United States and Canada | 818-576-5555
Medtronic MiniMed web site ) iii.,amsmama.noa

CD handling instructions

To protect the disc from scratches, fingerprints, dust particles and smears, never touch the
recording side or place it face down on a hard surface. Avoid exposing the disc to direct sunlight,
high temperatures, dust or dirt.



Indications for use

The Medtronic MiniMed Guardian Software and Com-Station are intended for use as accessories
to the Guardian. The Com-Station is used to download the data from the Guardian when
connected to a computer and using the Medtronic MiniMed Guardian software program. The
software is then used to view the data.

Contraindications

The cradle of the Com-station is not intended to be used with non-Medtronic MiniMed devices.

Warnings -

If you have concerns regarding the Medtronic MiniMed Guardian reports contact your
healthcare professional.

Requirements

Computer system

The minimum computer software and hardware requirements are:

- Microsoft Windows 98, 98SE, Windows NT 4.0 (service pack 3 or higher), Windows
Millennium Edition (ME), Windows 2000, Windows XP Home, and Windows XP Professional.

= Intel processors. Minimum of 32ZMB of RAM and 200 MHz processor speed.
- Microsoft Internet Explorer version 5.5 or higher.

= Up to 70 MB of free hard disk space for program installation or up to 120 MB of free hard
disk space required for Windows 98/98SE and Windows NT 4.0 systems if the Microsoft
Internet Explorer Version 5.5 upgrade is needed for instaltation from the program CD.

~ Additional disk space needed (optional) for saving files(1 MB each).
=~ Monitor/screen resolution of 800 x 600 pixels minimum and 16 bit and greater color
display.

» Serial communication port available and set to communicate with Microsoft Windows
operating systems.

2 Introduction
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= Pointing device (such as a mouse, touch pad or trackball) available and set to communicate
with Microsoft Windows operating systems.

= CD-ROM drive. .
« Adobe Acrobat Reader software version 4.0 or higher (optional for viewing thé User Guide).

Hardware accessories

The following are the hardware accessories used with the software. These accessories are not
included in the software package and may be ordered separately.

= Medtronic MiniMed Com-Station (MMT-7301)
+ Com-Station Power Cable with AC Adapter (MMT-7405)
« Serial Communications Interface Cable (MMT-7324)

Chapter 1 3
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Setting up your Com-Station

The Com-Station is a necessary component of the Medtronic MiniMed Guardian system, allowing
communication between the Guardian and a computer.

The Com-Station has the following
components:

.+ On/Off Switch - Light illuminates when
the Com-Station is ON.

- Cradle - A depression in the Com-5Station
where the Guardian is placed to
download data stored in its memory. The
cradle contains infrared (IR) ports, which
provide a communication link between
the Glucose Monitor and a computer to
allow a data downtoad to occur.

= Power cable port - The power supply
connection to the Com-Station.

~ Serial Cable - used to connect the Com-
Station to your computer.

- Communication Port A - connection for
your serial cable to your computer.

.« Communication Port B - not used with
this program.

«+ Device selector switch - Position to the
wave symbol to download the Guardian.

4 Introduction
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Connect Com-Station to the computer

1 Connect the serjal cable, which is supplied with the Com-Station, into an available serial Com

Port connector on the computer. These connectors are normally located in the rear of the
computer. . .

|

2 Connect the other end of the serial cable to the Port "A” Com Port on the rear of the Com-
Station.

Chapter 1 5
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3 Connect the power cable into a power source and connect the other end to the power cable
port on the rear of the Com-Station.

Lo
N

4 Position the on/off switch to the On position and the device selector switch to the wave icon '
position,

5 You are now ready to install the software on your computer.

Install the software
These steps are for a typical instaliation. Read and follow instructions - they appear on your
computer screen, .
1 Before proceeding with the installation, close all software programs on your computer (for
example; mail and word processing programs).
2 Insert the Guardian software CD into the CD drive with the label side facing up. The instatlation
program should automatically begin. If not, follow the remaining steps to instalt the software.
3 Select the START button on the Windows desktap and select Run. _

4 A dialogue box will appear.
aix

Type the nase of & program, Fokder, documert, of
Irkemot rasaurte, and Windows will epen ik For pou.

opan: [fDsetup.axe” =]

Mo ] coxe | orows. |

6 Introduction
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5 Select the BROWSE button, select your CD drive Find the "setup.exe” file.
ey T gy : Dt

WO
-
3

Fles of bpe: |Programs =] Cancel _

6 Select the OPEN button and the set-up window will open. The software looks for certain
Windows files already loaded on your computer. If the software cannot find these files, they will
automatically be installed. The fites loaded depend on the version of your Windows operating
system.

7 A window will appear if the Microsoft dcom98 file for Windows 98 is required. If the Microsoft
Data Access Components {mdac) file is required, the screen will show the mdac information.

8 Foltow all the screen prompts, and reboot if instructed to do so.

L ]
Note: If your computer has rebooted you will need to restart this procedure.

9 The Welcome window will appear on your nnSncﬂm_. screen. Follow the instructions that appear
on the windows.

10 Read the Software License Agreement.

11 Select YES if you agree with the Software License Agreement and wish to continue. Selecting NO
will cause you to be exited from the install program.

Chapter 1 7
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12 If YES is selected, the Choose Destination Location window will appear. Read and
follow the instructions in the window to continue instatling the software. When the i
installation is complete a message will appear stating the installation is complete. A g
icon will appear on your desktop named Guardian Solutions. -

13 Double-click the icon to open the software.

Adobe Acrobat Reader

This user guide is available to view from the Help menu of your Guardian software. Adobe
Acrobat Reader (version 4.0 or later) must be installed on your computer, Adobe Acrobat Reader
is provided on your Guardian software CD. If you do not have Adobe Acrobat Reader and you click
. on User Guide from the Help menu, you will get a message stating that Acrobat Reader is not
installed on your computer.

Follow these steps to install Adobe Acrobat Reader version 6.0:
Close the Guardian software.

Insert the Guardian software CD into the CD drive.
Click the START button on the Windows desktop.

Setect Run and a dialogue box will appear.

G AW N =

Type in the CD drive designation letter followed by a colon (C:, D:, etc.) and select the BROWSE
button.

Double-click the folder titled, "User Guide.”
7 Double-click the folder titled, "Adobe Acrobat Reader.”

8 Double-click the file titled, *AdbeRdr.env_full.exe” and follow the on-screen instructions to
install Adobe Acrobat Reader.

9 Restart the computer if prompted to do so.

-]

Note: If you encounter any problems installing Adobe Acrobat Reader on your computer,
refer to the Adobe Web site at www.adobe.com for information.

Introduction
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Chapter 2
Using your software

53
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Setting up your software

7R

Double-click the mouse pointer on the Guardian icon E¥™ on the Windows desktop. if this is

the first time you have opened the software, the User Preferences window will appear.

User preferences

Enter or select the required information in the fields. Move between tabs by selecting with
your mouse pointer. The following sections describe each tab under User Preferences.

General
The General tab is used to set up your Com-Station and select the time display.

1 Select COM1 or COM2 from the drop-down list under Com Port. This is the actual port the serial
cable is connected to on the back of your computer.

2 Click on the CHECK COM-STATION button. if the BRI S

correct Com Port has been selected, a message will P Sy e AN B

appear stating “Com-Station Ready.” | —r Pl e

u._u s Y st 10 [T e |

3 Click the OK button to acknowledge the message. s o

The Com Port field background color will be green if N =

you have selected the correct Com Port. PO A e
4 If the incorrect Com Port has been selected a *No —=

Corn-Station detected” message will appear and the

Com Port field will be yellow.

Chapter2 9



Recheck your connections and make sure the correct Com Port designation appears in the Com

Port field. You must define a Com Port at this time.

5 Time Display: Select the option n..:nno: for either 12 Hour or 24 Hour display on your reports. If
you select a 12-hour display, the charts will display 12-hour time frame with AM and PM. A 24-
hour selection will display a 24 hour display (i.e. 14:00).

6 Language Selection: Displays the tanguage used by the software {This field cannot be changed.)

Reports

The Reports tab is used to set the Reports parameters and to enable the

Hyer Preferences

- Quick Reports - -~

7L

sl

¥ Sensor Deteks

& Summary
" Detail Scimens

™ Senacr Modal Day

Gowd | BRepons | Cinicinto |

- Select C::a N

~ Glucass Unitg~—— -~ - ———--
= mg/d

" mmolll

- Meal Markets -~ -
& Grams CHO
~ Exchangs
" Othet

U

1 select the Reports tab at the top of the window.

2 Quick Reports: To select the Qu
Reports option under the Reports
types of reports can be checked, if de

10 Using your software

ick Reports you wish to print automatically via the Quick
menu, click the boxes next to the desired report. All three
sired. The Sensor Details has two options: Summary and

Quick Report function.
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Detail Screens. Select Summary to print all the days on one page. Select Detail Screens to print
each day's graph off on a separate page.

3 Glucose Units: Select the glucose units to be displayed in all the reports. Choose either mg/dl

or mmol/L. ,

4 Meal Markers: Select the units for the Meal Marker that corresponds with the type of meal units
entered into the Guardian. The meal markers in the Log Book report will reflect the units O
selected. =

Grams CHO (carbohydrate) is the default meal marker used for reporting meal values in units .
and grams. If you use the Exchange system select Exchange. The Exchange system is a method -
which uses food groups called “exchange” groups. One exchange unit contains approximately 15 . ;
grams of carbohydrates. .

Select Other if you are using a different system for carbohydrate counting and no units will be
-displayed with the values entered for the meal marker.

Clinic Info

Note: The Clinic Information screen is designed for use in a clinical setting. If using this
software at home, this information does not need to be entered ‘

The Clinic Info tab is used to enter the name, address and phone number of the clinic from
which the data was received. This information will print on the bottom of the reports. These
fields are optional.

= Click OK to save all setting changes and to exit User Preferences.
= Click CANCEL to exit without saving setting changes.

Chapter2 11
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Create a patient record

A new patient record must be created
each time you download the data from

s

. m.,._.oﬂ Name

the Guardian. The Patient Entry and Edit _
window appears automatically on the o Last Name
Main screen. This window cannot be ” I
closed. Perform the following steps to m Pationt 1D

create a new file. At least one letter or : _
number must be entered for the First
Name, Last Name, and Patient 1D fields.

The Physician field is optional. g _vlqila_m.
1 Enter the patient name. Use the tab
key to move through the fields.’

2 Enter the Patient ID number. Make sure
that a unique Patient 1D number is

entered for each patient.

3 Enter the Physician name, if desired.

4 The Download rm_ icon on the menu bar will now be visible.
5 You are now ready to download the data from the Guardian.

Note: Only one Guardian monitor download can be downloaded to a file. A new file must

be created each time the Guardian Monitor s an\innn\mk

12 Using your software
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Download the Guardian

Check to make sure that the Com-Station is properly
connected to the computer. Refer to Chapter 1 for detailed

Note: If a LOWBATT
alarm sounds when the
Guardian is turned on,
you must replace the
batteries before
downloading.

instructions.
1 Turn on the Com-Station. A green light on the On/Off switch
will itluminate indicating the Com-Station is on.
2 Turn on the Guardian. The Guardian must display the HOME
screen, otherwise the download will not take place.
3 Press the Device Selector switch on the Com-Station to the
wave icon position. .
4 Remove the belt clip from the Guardian monitor.
5 Place the Guardian face up into the Com-Station cradle. Make sure that the Guardian is lying
flat and snugly in the cradle. This wilt ensure that the IR communication ports are aligned.
6 Close all other software programs on your computer.
7 Select the menu, Download Omﬂmvoois_oma Glucose Monitor or the DOWNLOAD icon 't

Chapter 2
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8 The Download window appears.

Note: If you are in a clinic, make sure that the
Guardian that is being downloaded belongs to the
patient whose name appears on the top of the
download window.

9 Select the DOWNLOAD button to start the
download. Once the download is started, it can be
cancelled by selecting the CANCEL button.

If you decide you do not want to start the downtoad
process, select the CLOSE button to exit the
window without downloading.

Monitor:

10 A status bar will begin to move across the window. When the download is complete, a
*bownload Complete” window will appear.

i

Note: Refer to ﬁ..}su ter 4. "Troubleshooting” if you receive any error messages.

14 Using your software
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Save patient file

Note: The software will prompt you to save the File if you try to create a new file, if you
exit the software, or if you try to open another saved file.

1
2

Select File >Save As on the Menu bar,

The Save As window will appear. The
name is created automatically from
the information entered in the
Patient Entry screen with the current
date.

Select the SAVE button to save the
file,

If you wish to save the file using a
different file name, highlight the
automated file name and type in the
new desired file name.

S ) xd

Saveire | j PeteriData

Sanpiefdes
i) smith,_3_33793_20040126.mmd

To save the data in a different

directory or another drive, use the

folder icon on top of the Save window to select the desired location before selecting the SAVE
button.

Note: If you do not select a directory, your Ffiles will automatically be saved in the
following location on your computer,
C:\Program Files\MM Guardian Solutions\PatientData.

6

Select SAVE to save the data. If you download more than once in the mm._:m day and DO NOT want
to overwrite the existing file, enter a new file name before saving.

Chapter2 15
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Open an existing file

1 Select the Open File .ﬁ icon on the Menu bar.

Note: The default directory for your files is,
C:\Program Files\MM Guardian Solutions\PatientData.

2 The following window will open.

3 Select the desired file. The file
name will appear in the File Name
field at the bottom of the window.

4 Select the OPEN button to apen
the file.

5 The file is now open. The name
and patient ID for the file opened
will appear in the Patient Entry
and Edit window.

16 Using your software
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©0a_)_)ZH5_20040106.mmd
Samphe_A_) 2345 _20001004.mund
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Rename an existing file

The Rename Patient File feature allows you to rename as mx,“mzsm file. An existing file must be
open for this feature to be available.

1 Select the File>Rename Patient File on the Menu bar. The following window appears.
MRSV RS B .

i of iy A 1L R IR T
First Name
jPatient1
Lout Name
[TestFile ™

Patisnt ID
[so7s
CNRITICTE N o< L )
Fapuieans (I
Concel
Phys e

& Patignt 0
]

ﬁll.l.ll!.lll..i

2 Type the desired information into the fields.
3 Click the OK button and the following window will appear.

R x
u-.«-...n__.wwm!ﬂtﬂt» .H— + &1t -

Dos_J_12345_20040106.med
Sampln_A_)245_20001004. mmd
Sampla_F_1 XM5_20001004. mend

ey

& Sargle_K_{Z345_20000529. rend
!-‘ M| T Dos_K_IZM5_20000903.memx)
Drsiigp T Smith_X_{ 2345 _70000629.ced
™ Test Fle_P_5678_20040107.merd
L - ) Tost Flo_P_8879,_ 20040115, mend
oy Dot Test:2_1_7315_20001207.mma
7]
L
B o (R T
BN 5vve ostpe  [Fisdorso Dota (mmd) -1 Carcel \_

4 Click the SAVE button. The new file name will now appear in the Patient Entry & Edit window.
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Chapter 3
Reports

Once data from the Guardian has been downloaded, the software displays glucose values and
other information in a series of on-screen reports. The data can be viewed as graphical data,
summary statistics, and as numerical values. This section describes each of these reports.

Note:Any glucose values below 40 and above 400 are not displayed on the graph. These
values are “clipped” by the program. If data is logged below 40 and/or above 400 a flat
line will appear on the graph.

The reports can be viewed by clicking on an icon or
selecting one from the Reports Menu. There are three

types of reports: Log Book, Sensor Details, and Sensor
Modal Day. : Log " son m{.y,.
1 Open an existing patient file or create a new patient Book Dottty Modal Day

and download the data from the Guardian. Refer to
Chapter 2, “Using Your Software,” for this procedure.

2 Select the type of report that you wish to view by clicking an icon or selecting one from the
Reports menu.

3 The report that appears will be for the selected patient. You can click on the icons to view each
report without returning to the Main screen.

4 Repeat the previous three steps for each patient file, as required.

Chapter3 19



Log Book

This report displays all the information that has been stored in the Guardian. By using the
Sensor column on the left side you can select the areas that you would like to view,

L@
A'
S Patisnt:  --Jamag Finebady
o S Py
Detn Tima-. ltom [valus 2l :
- 11=fan04 959AM. Hourly Sensor High 99 Low 50 Mean 75
N “11-Jan04 958 AM Sansor 61 mgfL
11-Jan04 $53AM° Sensor 76 mg/dL
11-Jan04 953 AM Calibretion Points 98 mgfdL
ti=Jan04 S4RAM . Sensor B6 mg/dL
T JanBd 34IAM Sensor 89 mg/dL
T T et 330 M Sensor 73 mgfdL
d 1 1-Jendd $33AM Sansor 52 mg/dL
4T 1-lan04 320AM° Sansor 50 mg/di
L :r._n_i:m.na}f Almm et Ll 13
“M=tandt $23AM - Sansor 61 mg/dL
L VidaRr04 S8 AM Sansor 76 mgldL
T e 04 B1IAM Saasor 88 mg/dL
T Ao $UB AM Sensor 92 madL ) ,
| T e S AN Sensor 99 ma/dL -
T TR0 855 AM Hourly Sensor $High 95 Low 73 Meen B4
T a4 GE0AM Sensor 96 mg/dL
U 1TAlen 04 B53AM Sensor ‘87 mgdL
| [ 11xJonD4 848 AM Sensor 41 mg/dl
11 iandd 843AM Sensar B0 mgrdL
T 1) danld GI0AM - Sensot B0 mg/dL
© 1i-Jen04 B33 AM Sensor 78 mg/ol.
© 1 1-Jdar(4. B:28 AM Sensor 80 mg/dL.
11-Jan04 §23AM - Sensor Bl maydL -
.. Fyedispiey " _ ’ .”O..,Emo_oﬂ!_a _ E
[ b - A !-..E“._...??c: r_:m T-u _wmaw.r‘

1 Click in the small boxes with the left mouse button to check the items that you want to be

displayed.
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2 (Click the REDISPLAY button and a new listing will appear in the data display column located on

the right side of the window. Review the information and select different check box items, as
needed.

3 Select CLEAR SELECTIONS to clear all boxes.
4 Select the CLOSE button to exit the Log Book window.

Sensor readings
Shows all the sensor readings by date and time.

Sensor summary

Shows sensor summaries by the hour, and by the day, including high point, iow point and mean.
Mean is the average of all the glucose values measured during the hour or day. These entries

display from the most recent readings at the top of the window to the oldest at the bottom of
the window.

Calibration points
Shows the calibration BG values that were entered into the Guardian.

Excluded data

Lists all data that was not used in any calculations. (Example: 0 mg/dl) This data will not
appear in Sensor Details or in Summary calculations.

Glucose alarms

Shows each time an alert was given on the Guardian when the glucose values exceeded the
high or low set glucose limits. You can display these values separately by selecting either the
High Alarms or Low Alarms check box. .

Chapter3 21
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Event markers

Shows events that were entered into the Guardian, such as meals, exercise, and insulin. 1t also
includes the values and units entered that are associated with these events. Event markers need
to be set-up in the User Preferences window on the Report tab. See the "User Preferences” .
section in Chapter 2 for detailed information. o

Gap explanations

Displays sensor alarms, events, and excluded data. The Gap Explanations identifies glucose
data gaps of eight minutes or greater. Gap Explanations and Sensor Alarms and Events are atways :

viewed together.

Sensor Alarms and Events
Shows sensor alarms and events, such as LOW BATT and setting changes.

Sensor Details

Each Sensor Details report shows the daily glucose data over a 24 hour period for each day of
glucose data recorded by the Guardian. Glucose values are measured by the Guardian every five
minutes. Up to 288 data points each day are used to draw a profile line on each sensor detail
graph. A gap in the profile line indicates that glucose monitoring during that period was
interrupted. The days are color coded as fotlows:

= Sunday - Black

~ Monday - Blue

= Tuesday - Red

= Wednesday - Green

= Thursday - Magenta
= Friday - Cyan
~ Saturday - Orange

The Sensor Details Graph also shows all BG meter blood glucose values that were entered into
the Monitor during each 24 hour period for calibration. Event entries are also shown with
different symbols used for meals, insulin dosing, exercise and other events.

22 _.ﬂm orts
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Sensor Details Patient: Sampled Case
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= If you wish to look at an individual graph in detail, click'on the graph and it will enlarge to
fill the screen. Click anywhere on the enlarge graph to return it to the Sensor Details

summary view.

Use the arrow buttons on the bottom of the window to display the next or previous daily
series of glucose data.

= Exit the Sensor Details report by clicking on the CLOSE button located at the bottom right
corner of the window.
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Sensor Modal Day

The Madal Day Graph presents all of the Monitor data, superimposed over a 24-hour period with
each day presented as a separate plot line in a different color. Refer to the "Sensor Details”
section in this chapter or click on the LEGEND button to display the color legend. Up to 288
glucose data points are disptayed for each day, beginning at 12:00 AM. Click on the Modal Day
icon or select it from the Reports menu to view the graph.
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= Select a point on the graph with the mouse pointer and then click the left mouse button to
view the date, time, and glucose value of the trace at that point. This information will
appear in the gray area at the bottom of the window.

= Exit Sensor Modal Day by clicking on the CLOSE button located at the bottom right corner
of the window.

Print reports

All the reports can be printed using any printer connected to your computer. Use The Quick
Reports option if you wish to print more than one report. To set-up the Quick Reports go to
File/Preferences/Reports.

To print an individual report or the Sensor Data report, perform the following steps:
1 Open the report you want to print.

54

2 Click the Printer icon _@ on the menu bar, and the report will print.
or

3 Select File/Print from the menu bar. Your printer dialog box will appear. Select OK to print.

Quick reports

The Quick Reports feature in the Reports menu allows you to automatically print out mare than
one report at a time. Quick Reports are defined in the User Preferences window.

1 Open the desired patient file in the Patient Entry and Edit window.

2 Select Reports/Quick Reports from the Reports menu. All reports that have been selected in
Preferences will print to your printer.

Printer Setup

If you need to select a different printer than your default printer, use File/Printer Setup.
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Chapter 4

Troubleshooting

Software error messages

Message: Unable to download data. No Com-Station MMT-7301 detected. Please check Cable,
Power Switch, and Device Selector Switch.

Cause: Program is unable to communicate with the Com-Station and cannot download the
Guardian Monitor.

What to do:

Check that the long serial interface cable is securely attached to the desired serial Com Port
connector on the back of the computer, -

Check that the serial interface cable is securely attached to the Port A on the rear of the
Com-5tation. Make sure it is not connected to Port B on the side of the Com-Station.

Make sure the Com-Station Power Cable is connected to the power outlet and is plugged into
the back of the Com-Station. If plugging into a power strip, make sure the switch is On.

The Com-Station power switch should be pressed down towards the ON position and a light
should be glowing on the power switch,

Make sure the Com-Station device selector switch is pressed down towards the “Wave’ icon
position. .

Verify that the correct Com Port has been selected, i.e. COM1, COM2, COM3 in the progranmy

Preferences > General tab settings.

If the desired Com Port is not displayed on the drop down menu or if some other problem
exists then refer to section, “Setting up your computer to work with the Com-Station,” in

this chapter.
Use a different computer Communication Port if problems persist.

Repeat Monitor download.
If unable to resolve, contact Medtronic MiniMed Product Help Line.
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Message: No Device Power or Device not seated property.

Cause: _uq.om.ﬁmB is communicating with the Com-Station, but there is no response from the
Guardian Monitor.

What to do:

« Verify that the Guardian Monitor is turned ON and the main screen showing the current time e
is displayed on the Monitor.

Clear any alarm message that may be showing on the Guardian Monitor display.
Return to the main screen from any of the Monitor programming screens.

If a sensor Initialization period is currently in progress on the Monitor display then wait until
it is completed and the Monitor has been calibrated prior to attempting to download again.

Replace the batteries if the Low Battery lcon is displayed on the Guardian Monitor.

Clean the small window lenses visible within the Com-Station cradle and on the back of the
Monitor.

Make sure your Monitor is removed from its leather case and is lying flat in the Com-Station
cradle. Reposition the monitor, and press down on it to ensure it is aligned properly within
the cradle. .

Repeat Monitor download.
« If problem persists, contact Medtronic MiniMed Product Help Line.

e LY, s e T R R

Message: Device not responding or not seated properly.
Cause:  Program is communicating with the Com-Station and the Guardian Monitor but
communication with the Monitor was interrupted during the download.

What to do:

+ Do not remove the Monitor from the Com-Station while downloading data until the Download
Complete message is displayed.

» Verify that the Guardian Monitor is turned ON and the main screen showing the current time
is displayed on the Monitor.

« Clear any alarm message that may be showing on the Monitor display.
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Replace the batteries if the Low Battery Icon is displayed on the Monitor.

ﬁmm_.. the small window lenses visible within the Com-Station cradie and on the back of the
onitor.

Make sure your Monitor is lying flat in the Com-Station cradle. Reposition the monitor, and
press down on it to ensure it is aligned properly within the cradle.

Repeat download.
If problem persists, contact Medtronic MiniMed Product Help Line.

Message:

Cause:

Com Port not selected, Use File > Preferences to select.

The computer Com Port mmE:N. for communication with the Com-Station has not been
selected yet in the User Preferences screen. .

What to do:

&

[

From the Patient Entry and Edit screen, select File > Preferences to open the User
Preferences screen.

Set up the Com-5Station, connect it to your computer serial Com Port, and select the Com
Port number, i.e. COM1, COM2, COM3, etc. that the Com-Station serial cable is connected to
on your computer. .

Refer to the Com-Station User Guide for specific set-up instructions for that device.

Click on the CHECK COM-STATION button next to the Com Port setting to verify that the
correct Com Port is selected.

If the correct port number is selected the setting will appear shaded Green, If the wrong port
number is selected the setting will appear Yellow.

See "Setting up your computer to work with the Com-Station” section of this chapter for
further information on troubleshooting the Com Port setting.

If unable to resolve problems related to selecting and verifying the Com Port setting, contact
Medtronic MiniMed Product Help Line.
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Message: No Com Station Detected. Please check Cable, Power Switch and Device Selector

Switch.
Cause: . The CHECK COM-STATION test failed in the User Preferences screen due to either
selection of the wrong Com Port number, incorrect Com-Station setup, or a computer
. e
related problem with the selected Com Port. : Lo

What to do:

. Refer to the Com-Station User Guide for specific set-up instructions for that device.

« Check that the long serial interface cable is securely attached to the desired serial Com Port
connector on the back of the computer.

. Check that the serial interface cable is securely attached to the Port A on the rear of the
Com-Station. Make sure it is not connected to Port B on the side of the Com-Station.

. Make sure the Com-Station Power Cable is connected to the power outlet and is plugged into
the back of the Com-Station. If plugging into a power strip, make sure the switch 1s On.

« The Com-Station power switch should be pressed down towards the ON position and the light
should be glowing on the power switch.

« Make sure the Com-Station device selector switch is pressed down towards the "Wave' icon
position. . .

« Verify that the correct Com Port has been selected, i.e. COM1, COM2, COM3 that the Com-
Station serial cable is connected to on your computer.

« If the desired Com Port is not disptayed on the drop down menu then see section, "Setting
up your computer to work with the Com-Station,” in this chapter.

+ Use a different computer Communication Port if problem persists.

« Repeat the CHECK COM-STATION test to verify that the correct Com Port is selected and the
program is able to communicate with the Com-Station. )

« If the correct port number is selected the setting will mvumma shaded Green. If the wrong port
number is selected the setting will appear Yellow.

+ See "Setting up your computer to work with the Com-Station” section of this chapter for
further information on troubleshooting the Com Port setting.

« If unable to resolve problems related to the Com Port setting, contact Medtronic MiniMed
Product Help Line. :
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Message:
Cause:

You must Setect and Verify a Com Port for the Com-Station.

The OK button was pressed in the User Preferences screen before a computer
communication port setting was selected for communication with the Com-Station.

What to do:

Before exiting out of the Preferences screen, set-up the Com-Station, connect it to your
computer serial Com Port, and select the Com Port number, i.e. COM1, COM2, COM3, etc.
that the Com-Station serial cable is connected to on your computer.

Refer to the Com-Station User Guide for specific set-up instructions for that device.

Click on the CHECK COM-STATION button next to the Com Port setting to verify that the
correct Com Port is selected. :

If the correct port number is selected the setting will appear shaded Green. If the wrong port
number is selected the setting will appear Yellow.

See "Setting up your computer to work with the Com-Station” section of this chapter for
further information on troubleshooting the Com Port setting.

If unable to resolve problems related to the Com Port setting, contact Medtronic MiniMed
Product Help Line. _
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Message: You have not selected a Com Port for the Com-Station. Do you really want to cancel?
Cause: The CANCEL button was pressed in the User Preferences screen before a computer

communication port setting was selected for communication with the Com-Station.
What to do:

Before exiting or canceling out of the User Preferences screen, set-up the Com-Station,
connect it to your computer serial Com Port, and select the Com Port number, i.e. COM1,
COMZ, COM3, etc. that the Com-Station serial cable is connected to on your computer.

Refer to the Com-Station User Guide for specific set-up instructions for that device.

Click on the CHECK COM-STATION button next to the Com Port setting to verify that the
correct Com Port is selected. ,

If the correct port number is selected the setting will appear shaded green. If the wrong port
number is selected the setting will appear yellow.
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+ See Setting up your computer to work with the Com-Station section of this chapter for
further information on troubleshooting the Com Port setting.

. If unable to resolve probiems related to the Com Port setting, contact Medtronic MiniMed
Product Help Line.
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Message: Data File Open Error - Select a different data file

Cause: The file you selected to Open is either not compatible with this program, was modified
by another program or is damaged.

What to do:

. Select a different data file for Open with the file extension "*.mmd.”
. If necessary, downtoad the Monitor data again and create a new file.
« If problem persists, contact Medtronic MiniMed Product Help Line.
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Message: Print Error or Printer Not Defined.

Cause: An error occurred while printing, a printer has not been set up in Windows, or the print
function was Canceled.

What to do:

. Verify that a default printer has been set up in Windows Control Panel > Printers.

. Select Printer Setup from the Guardian Sotutions Fite menu to verify the desired printer has
been selected.

« Repeat the printing job.
. Ignore this message when canceling a print job.
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Setting up your computer to work with the
Com-Station

Selecting a valid com port

To solve communication problems, it may be necessary to select a different Com Port. Com
port 1 is the most common valid selection. Try each Com Port that appears in the
Communications Port drop down menu from the User Preferences >General tab screen.

Com Port 1 and/or 2 not listed

If com port 1 or 2 are not available from the drop down menu, a different software application
is using the missing com port.

Ta find the missing Com Port:
1 Exit the Medtronic MiniMed Solutions software.
2 Exit any application that communicates through the Com Ports.

3 Exit any applications that may be controlling the Com Ports. Typically these applications can be
found in the system tray (lower right corner of the desktop). For example, Palm handheld users
must exit HotSync Manager to gain access to the associated Com Port.

4 Restart the Medtronic MiniMed Guardian Solutions software.

5 Check the Communications Port drop down menu from the User Preferences >General tab
screen.

6 Retest communications with the Com Port using the CHECK COM-STATION button. .

If you continue to experience difficulty locating the Com Port or communicating with the Com-
Station then check the settings in the Windows operating system, complete the following steps:

1 Go to Start>Settings>Control Panel>System>Hardware>Device Manager

2 Find "Ports (COM and LPT)” and click the '+’ next to “Ports” to display the list of
communication ports available. .
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3 Select the desired Communications Port {i.e. COM1, COM2, or COM3) and right click to select

"Properties.”

4 Click ‘Port Settings’ and then 'Advanced’ to check the following settings are displayed.

5 Verify the required serial port settings are set correctly, as shown in the table below:

Port Settings

Set to

PC Com Port:

Enabled

Bits per second:

9600 (baud rate}

Data bits: 8

Parity: None

Stop bits: i

Flow control: xon/xoff
Advanced Set to

FIFO buffers:

Checked (enabled)

Receive buffer:

¥ high or greater

Transmit buffer

% high or greater

For Windows 98 systems:

4 Right-click on my computer form the desktop.

2 Select Properties

3 Select the Device Manager Tab.
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Check hardware connections
Refer to the Com-Station User Guide for hardware connection information.

Here are some tips for checking hardware connections:
. = Make sure there are no loose connections of the communication interface cable connected to

the computer and Com-Station.

'+ The communication interface cable attached to the computer should connect with Port A on the

Com-Station (on the back) not Port B (on the side).
Check the cable. Non-standard cables, cable extensi

ons, and cable adapters are common

sources of problems. The communication interface cabte (the long cable that was supplied with
the Com-Station) should be used to connect the Com-Station to the computer.

Do not use the short cable that was provided with

the Com-Station. Store the short cable

supplied with the Com-Station in a safe location for future use with other Medtronic MiniMed

applications,

Why are there gaps in my report data?

When noticing a gap in the graph, use the following steps to determine the cause of the
interruption.

Note the time and date where the plot first stops on the glucose profile graph.
Open the Logbook report and click CLEAR SELECTIONS. .
Click on Gap Explanations and Sensor Alarms & Events checkboxes and click the REDISPLAY

-

-

button. :

View the right side of the Log Book table to find alarms, events, and data gaps that may have
occurred. These conditions will explain gaps in the glucose profile graph.

The plot will resume once the alarm condition has b
has been entered into the Guardian. _

een resolved and an acceptable meter BG
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My software did not install

= Check the minimum system requirement.
= Close all other programs during software installation.

« Do not run other Medtronic MiniMed software programs at the same time while using the
Guardian Solutions software.

Uninstall the software ,

The software can be removed using the Add/Remove program in Microsoft Windows:
Click once on the START button.

Use the cursor to select SETTINGS, and a list of .ovg.o:m will appear.
Click once on Control Panel. A menu of control panel options will appear.
Double-click on the Add/Remove Programs option.

The Add/Remove window will open.

Find the “MM Guardian Solutions 2.0” program.

Click the CHANGE/REMOVE button.

Confirm the selection by clicking the YES TO ALL button.

After the software is removed, click on the OK button.

W 0 ~N O bk WN =
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Icon table

One Per Container/Package

(1)

Attention: See Instructions for Use

CD enclosed

©®

Important documents enclosed

e

Catalogue number

REF
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Software license agreement

By installing, copying or otherwise using this software you are consenting to be bound by
this agreement. If you do not agree to all of the terms of this agreement, promptly return the

complete software package and the accom

place you obtained them.
1 Definitions:

-p

“Medtronic MiniMed” means Medtronic
MiniMed, Inc.

“Software” means the computer
program contained in this package and
all updates to the computer program.
The term also includes all copies of any
part of the computer program.

“Documentation” means the User Guide
and any other printed materials
accompanying the Software.

"Product” means the Software and
Documentation.

2 Grant of License and Scope of Grant:

Medtronic MiniMed grants you a personal,
nonexclusive license to:

-

-

-

use the Software on a single computer;

use the Software on a netwaork,
provided that each person accessing the
Software through the network must
have a separate copy of the Software
licensed to that person;

use the Software on a second computer

so long as only one copy is used at a
time; _

oy

panying items (including written materials) to the

make one copy of the Software for
archival purposes, or copy the Software
onto the hard disk of your computer and
retain the original for archival
purposes.

Under the scope of this nonexclusive
license, you may not:

-

permit other individuals to use the
Software except under the terms listed
above;

permit concurrent use of the Software,
except under the terms listed above;

modify, translate, reverse engineer, de
compile, disassemble (except to the
extent applicable laws specifically
prohibit such restriction), or create
derivative works based on the Software;

copy the Software other than as
specified above;

sublicense, rent, lease, grant a security
interest in, or otherwise transfer rights
to the Software; or

remove any proprietary notices or
labels on the Software.
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3 Disclaimer of Warranties:

To the maximum extent permitted by
applicable law, Medtronic MiniMed reserves all
rights not expressly granted to you. Medtronic
MiniMed may cancel this License Agreement if
you do not abide by all of the terms and
conditions of the License Agreement, in which
case you must destroy all copies of the
Product and its component parts. Any written
or oral information or advice given by
Medtronic MiniMed dealers, distributors,
agents, or employees will in no way increase
the scope of this warranty. Notwithstanding,
any damages that you might incur for any
reason whatsoever, the entire liability of
Medtronic MiniMed under any provision of this
License Agreement and your exclusive remedy
will be, at the sole option of Medtronic
MiniMed, replacement of the Product or
Medtronic MiniMed’s reasonable effort to
make the Product meet the warranty set forth
above. The limitations, exclusions and
disclaimers herein shall apply to the maximum
extent permitted by applicable law, even if
any remedy fails its essential purpose.

MEDTRONIC MINIMED MAKES NO EXPRESS
WARRANTY AND MEDTRONIC MINIMED
EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES,
EXPRESS, IMPLIED, OR STATUTORY, INCLUDING
WARRANTIES OF MERCHANTABILITY, OF
FITNESS FOR A PARTICULAR PURPOSE OR
WARRANTY OF NONINFRINGEMENT OF THIRD
PARTIES’ RIGHTS. NO MEDTRONIC MINIMED
DEALER, AGENT OR EMPLOYEE 1S AUTHORIZED
TO MAKE ANY MODIFICATIONS, EXTENSIONS, OR
ADDITIONS TO THIS WARRANTY.

40 Software license agreement

if any modifications are made to the
Software by you during the warranty period, if
the Product is subjected ta accident, abuse,
or improper use; of if you violate the terms of
this Agreement, then this warranty shatl
immediately be terminated.

4 No Liability for Consequential Damages:

To the maximum extent permitted by
applicable law, in no event shall Medtronic
MiniMed, its employees, agents,
subcontractors or suppliers be liable for any
special, incidental, consequential or punitive
damages whatsoever (including without
limitation, damages for loss of profits,
business interruption, loss of information, or
other pecuniary loss} arising out of, or in any
way related to, the use of or inability to use
this Medtronic MiniMed Product, even in the
event of fault, tort {including negligence),
strict liability, breach of warranty of
Medtronic MiniMed, and if Medtronic MiniMed
has been advised of the possibility of such
damages. .

5 No Medical Advice:

This Product should be used solely in
conjunction with the consultation of a
physician familiar with the diagnosis and
treatment of diabetes. THIS PRODUCT DOES
NOT PROVIDE ANY MEDICAL ADVICE
WHATSOEVER AND MAY NOT BE RELIED UPON
FOR SUCH PURPOSE. By use of this Product,
the user agrees to indemnify and hold
Medtronic MiniMed harmless from any claim,
(iability, suit or damages sought from or
brought against Medtronic MiniMed (including
reasonable attorney’s fees and the allocable
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cost of in-house counsel) and arising as a
result of the use of the Software.

6 Copyright/Proprietary Protection:

The Product is owned by Medtronic MiniMed
and is protected by United States and
international Copyright laws and international
trade provisions. Medtronic MiniMed may have
patents, patent applications, trademarks,
copyrights or other intellectual property rights
covering subject matter in this document.
Except as expressly provided in this license
agreement, you do not have any license to
these patents, trademarks, copyrights, or
other intellectual property.
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